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The Mitel Networks™ 6100 CCS (Contact Center Solutions) suite is designed for the SX-2000, SX-
200, and SX-200 with Real Time (SX-200 EL/ML LIGHTWARE 17 Release 4.0 and greater) telephone 
systems. The 6100 CCS suite provides data collection, analysis and storage, forecasting, real-time 
monitoring, online messaging, historical reporting, data mining, and wall sign messaging. The suite 
consists of 6110 Contact Center Management, 6115 Contact Center Management (InterActive), 6120 
Contact Center Scheduling, and 6150 Mulitmedia Contact Center. 6110 CCM is the base application and 
the other applications are add-on applications. 

The Mitel Networks 6110 Contact Center Management User Tutorial provides a brief description of the 
6110 CCM architecture, a review of basic call center concepts, information on how to assign user 
security permissions, and tips on how to navigate 6110 CCM. It provides essential information on how 
to use the 6100 CCS applications, and provides practical exercises and questions designed to test your 
understanding of each application.
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prairieFyre uses the Microsoft BackOffice Server family of products—notably Windows 2000 Server, 
SQL Server, and Internet Information Server—to provide 6110 CCM, an Internet/intranet application 
that provides access to data on a Web browser. With 6110 CCM, you can manage your call center from 
anywhere, at any time.

6110 CCM has all the benefits of the Microsoft Distributed interNet Applications architecture (DNA). 
Using this architecture, 6110 CCM passes information from a client through an Internet/intranet, to a 
server running Windows NT Server through a SQL Server database, and back again.

Microsoft products support 6110 CCM in the following ways. 6110 CCM uses Microsoft Internet 
Information Server (IIS) to provide data to clients over the Internet. IIS is a Web-based server that 
displays call center information in a Web browser. Using IIS, you can monitor and program your call 
center on site, or from a remote location. 6110 CCM uses a Windows 2000 or NT Server operating and 
security system for the computer running as the 6110 CCM Enterprise Server, and SQL Server as the 
database engine. It uses Excel 97 or 2000 to present historical and forecast tables and charts.
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Typically, the telephone system is co-located with the 6110 CCM Enterprise Server as illustrated in 
Figure 1-1. On the 6110 CCM Enterprise Server, prairieFyre configures Comport 2 to accept the ACD 
data stream, and Comport 1 to accept the SMDR data stream. All components are connected over an RS-
232 serial cable or a Transmission Control Protocol-Internet Protocol (TCP-IP) socket.

Typically, the ACD stream is delivered from the telephone system DNIC circuit over a 2100 or 1100 
Dataset to Comport 2.

The SMDR stream is delivered in one of two ways:

      •    From the telephone system LPR1 port to Comport 1
      •    From the telephone system DNIC circuit over a 2100 or 1100 Dataset to Comport 1

You use a dataset to boost the SMDR data transmission if the 6110 CCM Enterprise Server is located 
over 50 feet from the telephone system.
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The SMDR stream provides call record data and the ACD stream provides agent event and calls waiting 
information. The SMDR stream provides the data feed for over eighty percent of the historical reports you 
produce. You use the ACD stream strictly for agent shift reporting.

��������	���
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The prairieFyre Service continuously updates the SuperAdvisor, AgentAdvisor, and WallBoarder real-time 
displays with telephone system data. It simultaneously forwards real-time data to the Structured Query 
Language (SQL) database and to connected clients over TCP-IP.

In addition, the prairieFyre Service updates the local hard drive with raw telephone system data files. The 
local hard drive backs up all of the data received from the telephone system. 6110 CCM uses this data in the 
summarization process that puts ACD metric information into the 6110 CCM database. The data is zipped 
to reduce storage requirements.
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The SQL database stores the wall sign and YourSite Database programming data in addition to all of the 
report records. The local hard drive stores vital, raw telephone system files. Alarms you set in the 
Management Console application inform you when the disk space on either drive is low.

����������	��
������
Call centers process a high volume of calls to meet marketing, sales, customer service, technical support, 
and other business objectives. A finely-tuned call center distributes calls efficiently and optimizes the use 
of agents and other resources. This section describes the inbound call center environment and how 
resources interact to process calls.

�����������	

An Automatic Call Distributor (ACD) is a specialized telephone system application for distributing 
incoming calls. The primary goal of an ACD is to ration calls to agents in a cost-effective manner that 
provides acceptable service to callers.

To optimize the use of agents, you cross-train them so they can handle a variety of inquiries. Rather than 
distributing calls to a number of small, specialized agent or extension groups, the ACD distributes them 
efficiently among the entire pool of available agents. When you consolidate resources, the same number of 
call center agents handle more calls while maintaining service levels.

You can program the ACD to ensure the first call to arrive reaches the first available agent or you can vary 
the order of calls and agents to provide superior service to preferred customers, and skills-based routing.

Figure 1-2 illustrates how call center resources interact to process calls.
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The path of an incoming call is as follows. A caller telephones your call center via the Public Switched 
Telephone Network (PSTN). (The PSTN is a global collection of Central Offices (COs) interconnected by 
long-distance telephone systems.) The local CO directs the call to one of your trunk groups. An available 
trunk picks up the call. Typically, calls from the PSTN arrive to the call center over incoming trunks and 
calls from the call center to the PSTN travel over outgoing trunks. If no trunks are available, the call does 
not get through to the system (is blocked) and the caller receives a busy signal.

When a trunk picks up a call, it forwards it through to a group of agents answering calls, or to some other 
answering point. The call arrives at the ACD queue of an agent group. The queue delays the call rather than 
blocking the call from entering the system. The time the caller waits in queue is the queue time. While 
waiting in queue, the caller listens to product features, announcements, or other messages provided by a 
Recorded Announcement Device (RAD). The caller can wait patiently in queue for an available agent, 
leave a voice mail message, or hang up (abandon) the call.

An agent answers the call. The time the caller spends talking to the agent is the talk time. When the call is 
completed, the agent may need to perform additional work associated with the call. The time taken to 
perform this work is the wrap up time.

�������������������������������
Second-by-second (real-time) statistics presented on wall signs and desktop monitors enable you to monitor 
the service provided to callers. You can monitor the number of incoming calls, the time it takes to process 
them, the queue load, and the availability of agents using a Management Information System (MIS). The 
term MIS refers to the processing of data produced by the telephone system. The MIS uses telephone 
system records to provide forecasting, real-time monitoring, and reporting functions.

����������������	�������������������
To optimize traffic-carrying efficiency ensure

      •    Sufficient trunks are available to carry incoming calls
      •    Callers experience a delay in queue
      •    There is a random distribution of calls among available agents

������������������ �!�����������
You schedule agents so the number of incoming calls at any given time typically exceeds the number of 
agents currently available. The intent is that callers experience a slight delay before agents answer their 
calls. The expected number of incoming calls forecasted for the time of day, and day of the week influence 
scheduling decisions.
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Call routing options you program in the telephone system provide a set of instructions that automate the 
movement of calls to their intended answering points. You can define options—if the caller dials 1 forward 
the call to customer service. You can specify re-routing for calls not answered after a set period of time and 
parse incoming Automatic Number Identification (ANI) and Dialed Number Identification Service (DNIS) 
data to direct call routing. Figure 1-3 illustrates some common routing options.

��������	"��������������
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In the simplest call scenario, a single trunk picks up an incoming call to your call center. The telephone 
system presents the caller with options to dial various answering points. The caller dials an individual agent 
at an extension through a queue number. A queue number is an address mechanism for a queue or other 
answering point. The programming associated with the queue number defines the routing and timing 
features of the call. The telephone system collects data on the agent and trunk involved in the call. The 
ACD management reporting application produces reports on agent and trunk activity.

����������%����
In the next call scenario a trunk group picks up an incoming call to your call center. The system presents the 
caller with options to dial various answering points. The caller dials queue number 1 to reach queue 1 
(Customer Service). The system forwards the call to the first available agent in the agent or extension group 
associated with queue 1. The call is an ACD call because one dialable number represents all agents in the 
group. The telephone system collects data records for the call. The ACD management software produces 
Queue Reports on queue 1.



�



��
���
 ���
5�������
������&������
An ACD call that is not answered immediately is placed in a queue. If an agent does not pick up the call 
after a set amount of time (the overflow time) the system places the call in the queue of another agent 
group, in addition to keeping it in the first queue. The first available agent in either group answers the call. 
The overflow feature limits the delay faced by callers by queuing calls against two or more agent groups, as 
illustrated in Figure 1-4.

��������������
You can program the telephone system to direct a queue delayed call to voice mail or to another answering 
point. The interflow timer runs independently of the overflow timer. If the interflow timer expires, the 
system removes the call from the queue and re-directs it to another answering point, such as a trunk or 
voice mail.
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�������������
���
�������
����
�����������
The inbound call center environment has unique characteristics that must be considered in effective 
planning and management.

(���� ������������������������&��
Calls arrive randomly to call centers. You cannot predict the minute-to-minute arrival of calls. This results 
in unanticipated increases in workload, and impacts staffing calculations and the load carried by system and 
network resources.

You can predict the pattern of call arrivals for 15-minute or longer intervals. For example, you can predict 
that next Monday between 1:00 P.M. and 1:30 P.M. you will receive 60 phone calls. However, you cannot 
predict how many calls will arrive in the first five minutes, the second five minutes, and so on.
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The following factors influence a caller’s tolerance to queue delays:

      •    The immediacy of the caller’s requirement
      •    The availability of similar products or services
      •    The caller’s expectations for service
      •    The time available to make the call
      •    Whether or not the caller is paying for the call
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This tutorial uses the following document conventions.

�������)�$������$

The following terms apply to actions you perform in dialog boxes:

•    Click precedes items you select with the mouse, such as buttons and items in list boxes.
•    Press precedes items you select on the keyboard.
•    Select or clear precedes items you turn on or turn off, such as check boxes.
•    Select precedes items you select in combo boxes (text boxes with attached list boxes).
•    Using a drag-and-drop operation means clicking an object on the screen with the left mouse button, and 

pressing the mouse button while you drag the object to a different position on the screen.

For example: click OK; press ENTER; select the PFDatabase check box.

*�����

Italic typeface is used to set off words, letters, and numbers referred to as themselves in the text, and for 
characters or words you type in the user interface. For example: overflow is the routing of calls to more than 
one queue; the program saves text files as MMDDYYYY.sql.

+��������� ��,�

Quotation marks are used for memorable or well known information. For example: perform “what-if” 
scenarios on the resultant data.

-���

Bold designates paths you select in your root directory and items you click, press, or select. For example: 
Click OK; delete 50 and insert 60; select the Check database integrity check box.

������� �

Menu items you select are separated by an arrow [=>]. For example, File=>Open tells you to select the 
Open submenu on the File menu.

�����������
Before you begin the tutorial it is essential

      •    6110 CCM is installed. (See the Mitel Networks 6110 Contact Center Management Installation 
Guide for more information.)

      •    You are connected to the SX-2000, the SX-200 or the SX-200 with Real Time.
      •    On the 6110 CCM Enterprise Server, you have been assigned a user account and 6110 CCM user 

permissions.
      •    There are call center devices programmed in the YourSite Database.
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After you install 6110 CCM, you must grant users access to the 6110 CCM Web site. When users browse to 
the 6110 CCM Enterprise server to start 6110 CCM, security requires they provide a valid user name and 
password. 6110 CCM security challenges users a second time if they attempt to run an application to which 
they are not permitted access.

Starting with version 2.8, Mitel Networks 6110 CCM has new security features. The security can now be as 
basic or as flexible (advanced) as you need it. 

With security roles, you can define what you want users to have access to. By default the security role is 
Not Restricted (to the Web site). However you have the option of creating a more customized security role 
and then assign users to it. 

�����
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The following tips will help you navigate efficiently in the 6110 CCM browser environment.
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Sometimes you will need to view two or more 6110 CCM applications simultaneously. For example, you 
open two or more 6110 CCM Web sessions to compare report data to SMDR search results.

To run multiple 6110 CCM sessions:
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You start the first instance of 6110 CCM by clicking the 6110 CCM desktop icon (on the server computer) 
or by starting Windows Explorer and typing in the 6110 CCM Server address (on a client computer).

You access the second (and subsequent) copies of 6110 CCM by clicking the Internet Explorer icon on the 
Windows Taskbar and selecting 6110 CCM from your list of favorites. Alternatively, you can click 
Tools=>Internet Options and set your Home page to the 6110 CCM application (your 6110 CCM Enterprise 
Server IP address) and run multiple instances of 6110 CCM simultaneously.

You can open multiple browser sessions of the SuperAdvisor, YourSite Configuration, ACD Inspector, 
SMDR Inspector, and ACDLink applications from their respective menus.
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For example, to open a new session of SMDR Inspector:
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6110 CCM displays the new SMDR Inspector session in addition to your original 6110 CCM session.

NOTE: You can alternate between the two 6110 CCM sessions by holding down the Alt key and pressing 
the Tab key until you locate the desired session.
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Supervisor monitors, agent monitors, and reader boards (wall signs) display real-time telephone system 
data. Supervisors and agents view real-time statistics over the intranet or Internet in the SuperAdvisor and 
AgentAdvisor applications respectively. Supervisors display text messages and call center statistics on one 
or more Spectrum light emitting diode (LED) wall signs using WallBoarder. (See AgentAdvisor and 
WallBoarder for more information on the AgentAdvisor and WallBoarder applications.)

The prairieFyre Service continuously updates the SuperAdvisor, AgentAdvisor, and WallBoarder displays 
for the SX-2000 and the SX-200 with Real Time (SX-200 EL/ML LIGHTWARE Release 4.0 and greater) 
with SMDR and ACD telephone system records.

Figure 1-5 illustrates the connectivity between the prairieFyre Service and connected clients viewing the 
6110 CCM real-time applications.

��������	.��(������ �� �������



�



��
���
 ���
5�������
������������
SuperAdvisor displays agent and queue statistics in color-coded grids. The grid cells change color when 
performance changes to keep supervisors informed of the service provided to callers. SuperAdvisor 
provides statistics in real-time, by 15-minute interval, over-the business-day, and by shift.

For the SX-2000 and the SX-200 with Real Time, when you click RealTime=>SuperAdvisor Figure 1-6 
appears.
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For the SX-2000 and the SX-200 with Real Time, SuperAdvisor consists of 11 monitors. The Agent State 
by Position, Employee State by Position, Agent State by Time, Employee State by Time, and Agent Shift 
monitors provide agent availability statistics. The Queue by Period, Queue Now, and Queue Group Now 
monitors provide queue statistics. The Call Count by Queue, Queue Service Level Percent, and Queue 
Status monitors provide graphic displays on queues statistics.

On the SuperAdvisor main screen, you can create profiles to save threshold settings and display 
characteristics you define for monitors. The Save button saves all open monitors under one profile name. 
The Load button loads existing profiles and deletes profiles.

When you open a new monitor, the computer monitor icon turns green to verify you are receiving data. If 
the computer icon is marked with a red X, SuperAdvisor is not receiving data.

When you select devices, such as agents or queues, to display on a monitor you can specify the devices be 
sorted alphabetically or by device ID, in ascending or descending order. SuperAdvisor displays the devices 
across the grid in the order you specify. (See Viewing real-time statistics for more information).

NOTE: 6110 CCM permissions are based on database teams and groups. In programming the YourSite 
Database, you must create agent IDs and associate the agents to employees and to agent groups. You must 
associate the agent groups to the queues for which they answer calls. You must associate the employees to 
employee groups and the queues to queue groups. You must create these associations in the database in 
order to view real-time data and report on these devices. If you are reporting on extensions, trunks, DNIS 
numbers, and account codes, you must add these devices to the YourSite Database and associate the 
extensions to extension groups, trunks to trunk groups, and DNIS numbers to DNIS groups.
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The following exercises will familiarize you with SuperAdvisor. Using the Agent State by Position and 
Queue Now grids you will

      •    Select call center elements (devices) to monitor.
      •    Add devices to grids, rearrange them, resize them, and sort them.
      •    Hide grid fields.
      •    Define performance thresholds for devices and ACD variables.
      •    Define grid styles.
      •    Create profiles to save grid and chart characteristics.
      •    Copy profiles to other client computers.
      •    Chat online with supervisors and agents.
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NOTE:  An agent must be a member of an agent group defined in the YourSite Database in order for you to 
view the agent in SuperAdvisor or AgentAdvisor.

To view the real-time activities of agents:
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The SuperAdvisor main screen appears.
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The Agent State by Position grid appears. It displays the state, agent name, agent ID, extension number (or 
queue number for agents On ACD or on ACD Hold) and time in state for each agent.
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To add additional agents to the Agent State by Position grid:
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SuperAdvisor adds the agents to the bottom of the Agent State by Position grid.

NOTE:  If you right-click a cell and add a single agent to the grid, the new agent replaces the agent in the 
current cell.
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To rearrange and resize agent cells on the Agent State by Position grid:
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This resizes all agent state icons on the grid.
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To enlarge the grid frame:







��

9���.����4
���
�����
�����
������
��
���
!�����	
��!
������#
�
!���.��!.!���
����������

To auto-fit the grid to the frame:
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The grid cells change size to fit the new grid dimensions.

To sort agents on the Agent State by Position grid:
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SuperAdvisor sorts the agents by state and time in state. SuperAdvisor displays the agents across the grid in 
the following order:

      •    On ACD agents
      •    ACD Hold agents
      •    Wrap Up agents
      •    Idle agents
      •    On Non ACD agents
      •    Non ACD Hold agents
      •    Outbnd agents
      •    Outbnd Hold agents
      •    Make Busy agents
      •    Do Not Disturb agents
      •    Log Off agents
      •    Unknown agents

To view the real-time activities of queues:
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SuperAdvisor displays the Queue Now grid on top of the Agent State by Position grid.

NOTE:  A queue must be a member of a queue group defined in the YourSite Database in order for you to 
view the queue in SuperAdvisor or AgentAdvisor.
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You can hide grid fields (columns) you are not interested in viewing on the Agent Shift grid, and on all 
grids that display queue information. To hide grid fields on the Queue Now grid:
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You can customize the appearance of grid elements, such as column and row headers, on all SuperAdvisor 
grids.

To define grid styles on the Queue Now grid:
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The Grid Properties screen appears.
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NOTE:  You can select multiple grid elements by pressing Shift or Control and apply styles across them.
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SuperAdvisor displays statistics in color-coded grid cells on your desktop. The grid cells and statistics 
change color when performance changes to keep you informed of the service provided to callers.

When performance thresholds are not being met, SuperAdvisor appears on top of all open desktop 
applications and “beeps”. You can optionally select an alternate .wav file to play.

To define performance thresholds and corresponding colors for ACD variables:
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The Grid Properties screen appears.







,�

����4
���
� ���
��"�






��

7�
���
���0
����%��1����� ��
����(
����4
�
�����"���






+�

 �!��
������
 ���(
������
�����
������
���
���
����������






��

����4
/�%���
���
��!
�
����
���
��!
������	
����#
��������!
������
���
5�������!


�






��

>��������	
������
���
��	
��
$�$
����4
"�2
��
!�����	
������!�����
��
���
��
���


�����
������������
����
���
��������!
���!������
���
��������!�






$�

>��������	
������
���
"��
�� ����
#���
����4
"�2
��
����
������!�����
"���
����


���
��������!
���!������
���
��������!�






%�

0�����
�����
+
��
$
��
!�����
����#�����
���
5�������!
,
��!
5�������!
��






/�

0�����
�����
�
��
$
��
!�����
��������!�
���
�����
������#����
�����"����




��

����4
���



+



��
���
 ���
5�������
NOTE:  If you have more than one Agent/Employee State by Position or Agent/Employee State by Time 
grid displayed, any changes you make to the ACD variable threshold programming or grid styles effect all 
open Agent/Employee State by Position or Agent/Employee State by Time monitors.

You can define performance thresholds for individual or multiple queues on the Agent Shift, Queue Now, 
Queue Group Now, and Queue by Period monitors.

To define performance thresholds and corresponding colors for devices and ACD variables:
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The Grid Properties screen appears.
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NOTE: You can select the Select All check box to apply threshold settings for a performance variable 
across all available queues. If you select the Standard Grid Color check box the background color turns 
white for the active performance variable.
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On the SuperAdvisor main screen you can create profiles to save threshold settings and display 
characteristics you define for monitors. The Save button saves all open monitors under one profile name. 
The Load button loads existing profiles and deletes profiles.

NOTE: You must save your open monitors to a profile before you select a different 6110 CCM application, 
such as YourSite, or Report Inbox, or your programming in SuperAdvisor will be lost.

By default, the profile is saved in the SuperAdvisor folder. 
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To clear monitors currently displayed:
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SuperAdvisor closes all monitors.

To retrieve a profile saved in SuperAdvisor:
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SuperAdvisor displays the monitors for the profile.



�



��
���
 ���
5�������
�������
������
$���
�����!�����
� 
�����
You can communicate essential information to one or more agents or supervisors quickly and securely with 
the SuperAdvisor ChatLine. You can broadcast service alerts, coach agents, and send timely messages, such 
as asking an agent to delay going on break when it is busy.

NOTE:  You must log on to the SuperAdvisor chat module in order to send and receive online messages. 
When you receive a message, SuperAdvisor displays it immediately on top of all open windows.

To chat online with agents or supervisors:
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Figure 1-8 appears.
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The Device IDs screen appears.
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The agents or supervisors you selected appear in the Chat Sessions window. The Chat Sessions window 
lists the agent ID and name of each agent you selected. Supervisors are identified by name only.

NOTE:  On the agent grids, if you right-click an agent’s cell and click Chat the agent appears in the Chat 
Sessions window automatically.

Blue text appears in the chat window to confirm SuperAdvisor sent your message. The recipients response 
to your message appears in the chat window below a red header.

To send a subsequent message to agents or supervisors:
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Alternatively, you can type a message, click Broadcast, select a recipient, and click OK to send a 
subsequent message to agents or supervisors.

To reply to a message, type a message and press Enter. ChatLine sends your response to the person who 
most recently sent you a message (the person listed at the bottom of your chat window). To reply to a 
previous message, select the individual in the Chat Sessions window, type a message, and click Send.

NOTE: If the agent or supervisor is logged out at the time you send the message, ChatLine marks the 
agent’s or supervisor’s icon (in the Chat Sessions window) with a red X. If you send a message to an agent 
who does not have AgentAdvisor open, ChatLine marks the agent’s icon with a red X.
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Read the following questions and select one answer.
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The AgentAdvisor application provides real-time statistics for the SX-2000 and SX-200 with Real Time 
systems. It displays statistics in color-coded sections on the agent’s desktop. The display keeps agents 
informed of significant changes in the service provided to callers.

NOTE: When you minimize AgentAdvisor a green AgentAdvisor icon appears on your system tray. You 
double-click the icon to restore AgentAdvisor. 
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The following exercises will familiarize you with AgentAdvisor. Using the Agent State by Position and 
Queue Now grids you will

      •    Select call center elements (devices) to monitor.
      •    Add devices to grids, rearrange them, resize them, and sort them.
      •    Hide grid fields.
      •    Define performance thresholds for devices and ACD variables.
      •    Define grid styles.
      •    Create profiles.
      •    Copy profiles to other client computers.
      •    Chat online with supervisors.
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NOTE:  In the YourSite Database, an agent must be a member of an agent group, and must be associated to 
an employee ID in order for you to view the agent in AgentAdvisor. An employee must be a member of an 
employee group in order for you to view the employee in AgentAdvisor. A queue must be a member of a 
queue group and have at least one agent group associated to it in order for you to view the queue in 
AgentAdvisor. This is to support real-time and report permissions: you define permissions for database 
groups.

To view the real-time activities of agents:
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You enter an employee ID to enable you to chat online with supervisors.

Figure 1-10 appears.
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You enter profile names to save display parameters and alarm characteristics you define for agents and 
queues.
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The Monitor Selection screen appears.
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The Device IDs screen appears.
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The Agent State by Position grid appears.

The Agent State by Position grid displays the state, agent name, agent ID, extension number (or queue 
number for agents On ACD or on ACD Hold) and time in state for each agent.
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If you hide the title bar, you can move the display by holding down the shift key, clicking the grid, and 
performing a drag-and-drop operation.

To start a second instance of AgentAdvisor:
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You should now have two AgentAdvisor monitors running simultaneously.
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To add additional agents to the Agent State by Position grid:
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AgentAdvisor adds the agents to the bottom of the Agent State by Position grid.

NOTE:  If you right-click a cell and add a single agent to the grid, the new agent replaces the agent in the 
current cell.

To rearrange and resize agent cells on the Agent State by Position grid:
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This resizes all agent state icons on the grid.
To enlarge the grid frame:
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To auto-fit the grid to the frame:
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The grid cells change size to fit the new grid dimensions.

To sort agents on the Agent State by Position grid:
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AgentAdvisor sorts the agents by state and time in state and displays the agents across the grid in the 
following order:

      •    On ACD agents
      •    ACD Hold agents
      •    Wrap Up agents
      •    Idle agents
      •    On Non ACD agents
      •    Non ACD Hold agents
      •    Outbnd agents
      •    Outbnd Hold agents
      •    Make Busy agents
      •    Do Not Disturb agents
      •    Log Off agents
      •    Unknown agents
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On the Queue Now grid you can optionally hide the grid fields (columns) you are not interested in viewing.

To hide columns on the Queue Now grid:
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AgentAdvisor hides the grid fields.
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You can customize the appearance of grid elements, such as column and row headers on all AgentAdvisor 
grids.

To define grid styles on the Queue Now grid:
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The Grid Properties screen appears.
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NOTE:  You can apply styles across multiple grid elements by pressing Shift or Control.
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Agents can program performance thresholds in AgentAdvisor, or supervisors can define performance 
thresholds and copy them to all agents.

To define performance thresholds and corresponding colors for ACD variables on the Agent State by 
Position grid:
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The Grid Properties screen appears.
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You can define performance thresholds and corresponding colors for individual or multiple queues on the 
Queue Now and Agent Group monitors.

To define performance thresholds for queues and ACD variables on the Queue Now grid:
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The Grid Properties screen appears.
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NOTE: You can click the Select All check box to apply the threshold settings for a performance variable 
across all available queues. If you select the Standard Grid Color check box, the background color turns 
white for the active performance variable.
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In AgentAdvisor you can create profiles to save threshold settings and display characteristics you define for 
monitors.

To save the threshold settings and display characteristics for a grid currently displayed in AgentAdvisor:
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To retrieve a profile you created: 
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The Browse, Open or Create a Profile window appears.
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AgentAdvisor displays the monitor for the profile.
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You can create one or more profiles in AgentAdvisor and make them available to agents (who have 
AgentAdvisor installed).

To copy a profile to a agent’s computer:
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This is the directory where AgentAdvisor is installed.
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It is an .aaf file.
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The agent can then gain access to the profile on their computer in AgentAdvisor.
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With the AgentAdvisor chat feature, agents can communicate essential information to supervisors or agents 
quickly and securely. Agents requiring help on calls can consult with supervisors online and provide 
immediate feedback to clients, without having to leave their seats.

NOTE: You must log on to AgentAdvisor in order to send and receive messages. When you receive a 
message, AgentAdvisor displays it immediately on top of all open windows.

To chat online with supervisors or agents:
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Figure 1-11 appears.
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Blue text appears in the chat window to confirm AgentAdvisor sent the message. The supervisor’s or 
agent’s response to the message appears in the chat window below a red header.

To reply to a message, type a message and press Enter. ChatLine sends your response to the person who 
most recently sent you a message, that is, the person listed at the bottom of your chat window. To reply to a 
previous message, type in a message, click Send to, select a supervisor or agent from the list, and click OK.
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Read the following questions and select one answer.

�
'����
��
���
���������
�����#����
��
���
����H






��

������!�����
��
�
����!�����
������������





"�

������!�����
���	
���4�
����
���
���������






��

��
�����
#���
"�
�
#�#"��
��
��
�����
�����
!�����!
��
���
6�������
����"���
��


��!��
���
	��
��
����
���
�����
��
������!������





!�

7�
	��
����
��
�D.,��
���������
�	���#
<����
���!����
���
�D.,��
�������
+��


�������=
������
���
���
����
����.��#�
!���
��
������!������

,�
'����
��
���
���������
�����#����
��
���
����H






��

6��
���
4���
������!�����
��
���
��
���
�����
������������
��
	���
!��4����





"�

6��
���
!�����	
������!�����
���������	
��
����)������	
��
	���
!��4����





��

'���
������!�����(
	��
���
����
������
����
�����#���
��!
������������





!�

'���
������!�����(
	��
���
������
��������
��
����
�����
�����#�����(
��������!


��������(
��!
!�����	
���������������
���
�
!�����	�!
#�������





��

������
#���
���
��
��
������!�����
�����
�#���	��
7��
��
��!��
��
�������
������


#��������



,�



��
���
 ���
5�������
������������������	��
�	�����
The Reporter and Scheduled Reports applications provide detailed call center statistics. You can generate  
reports for 15, 30, or 60-minute intervals across any series of days you specify. You use Reporter to produce 
run-on-demand reports, and Scheduled Reports to set up timetables for generating reports. 
4Sight provides forecast reports that predict the number of agents you require based on historical data.

The Reporter and Scheduled Reports programs have Agent, Queue, Employee, Team, Extension, Trunk, 
4Sight, and DNIS Report categories. There is also a Custom Reports category for users who are licensed for 
custom reports.

When you generate reports the Report Writer sends them to your personal report inbox. The reports you 
generate are available only to you. You can gain access to your reports by clicking the Report Inbox menu.

When you click the Reporting menu Figure 1-12 appears.

��������	����(��������� ���� ����������



,$
��������
The Reporter application has Agent, Queue, Employee, Team, Extension, Trunk, 4Sight, and DNIS Report 
categories. There is also a Custom Reports category for users who are licensed for custom reports. You can 
restrict access to any or all reports with by Advanced Security Roles using Report lists. See “Security” on 
page 47.
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The Report Distributor application prints and e-mails your reports and displays the status of your printing 
and mailing jobs. It runs in the system tray on your computer and must be running at all times in order to 
print and e-mail reports automatically.

The Report Distributor runs under the identity of the logged on user and prints to the default printer as 
defined by the logged on user. A user who logs on but does not have a default printer setup, or does not 
have adequate permissions to use the default printer causes the Report Distributor to fail each print job that 
it attempts to action. Users must have a mail client installed in order for the Report Distributor to e-mail 
reports.

In order to e-mail reports to other users your network requires a properly configured MAPI mail client.

If you have not already configured Report Distributor on your client computer, to automate the printing of 
reports and e-mails:
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If the Report Distributor icon is not displayed on the system tray, click Start=>prairieFyre Software 
Inc=>6110 CCM Report Distributor to start the Report Distributor.
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The following exercises will familiarize you with Reporter. Using a Queue Group Abandon Spectrum by 
Period Report you will

      •    Generate a run-on-demand report.
      •    Review report details.
      •    View the report grid and chart in Excel in your browser.
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Before you generate any reports, ensure you select Help=>Client Download and download the 6110 CCM 
Excel report templates from the Client Download page to your computer.

If you intend to e-mail the report to one or more recipients you must add the recipients to a mailing list and 
associate the recipients to a group.

To set up groups for e-mailing reports:
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To run the report:
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Figure 1-13 appears.
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NOTE: You can generate multiple queue reports simultaneously by selecting more than one queue group in 
the Queue Group list and clicking Submit. This function applies to all report types.

NOTE:  Each time you run a report, Reporter retains the Start Hour, End Hour, Interval, and Days to 
Include report parameters last selected.
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The Report Confirmation screen appears. 
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The Report Inbox application displays all run-on-demand, scheduled, and forecast reports generated under 
your user name.

To view report details:
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Figure 1-14 appears.
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The Status field confirms if your report is ready. When Complete appears in the status field the report is 
waiting in your Report Inbox. When Pending appears, the report is not ready. No Data means no records 
were available for the parameters you specified. Failed means the report did not generate. If a report fails, 
the Report Writer logs errors in the NT event log. Re-Submit regenerates the report.
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To view the report grid and chart:
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When you click View, the client-side Report Writer (Web page) retrieves the data files from the 6110 CCM 
Server and re-creates the data set on your computer. It starts Excel and displays the report spreadsheet and 
graph. If you click View to open a second report, Report Writer displays it in the same Excel session

You can graph other results by highlighting one or more columns of data in the spreadsheet and using the 
Excel Chart Wizard. You can also use the Excel chart wizard to change the grid style.



�
While the report is open on your computer, you can save it to your local disc drive and e-mail it to others, or 
place it on a shared network drive for others to access. In order to e-mail reports to other users your network 
requires a properly configured MAPI mail client. (See your system administrator for details.) If you e-mail 
reports to other users they must have Excel installed on their computers to view the reports.

NOTE: Report Writer deletes all reports that are 30 days or older from your report inbox. For run-on-
demand reports, the request date governs the reports age. For scheduled reports, the date the system runs 
the report governs the reports age. You save any reports you want to retain beyond 30 days to your hard 
drive or network home directory.
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The prairieFyre Service compares the raw telephone system data to the configuration of the YourSite 
database and forward relevant files to the Structured Query Language (SQL) database in real time. Reports 
are run based on the data in the SQL database.

NOTE: 6110 CCM permissions are based on database teams and groups. In programming the YourSite 
Database, you must create agent IDs and associate the agents to employees and to agent groups. You must 
associate the agent groups to the queues for which they answer calls. You must associate the employees to 
employee groups and the queues to queue groups. You must create these associations in the database in 
order to view real-time data and report on these devices. If you are reporting on extensions, trunks, DNIS 
numbers, and account codes, you must add these devices to the YourSite Database and associate the 
extensions to extension groups, trunks to trunk groups, and DNIS numbers to DNIS groups.

If you run a report and notice that the data for a particular device is missing from the report output, verify 
the device is programmed in the telephone system and in the YourSite Database. If you determine the 
device is missing from the database, add it to the database and use the Summarize Data command (on the 
Management Console program) to update the prairieFyre Service and the SQL database with the complete 
telephone system data stored on the local hard drive. You can then produce reports on the device.
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You can delete run-on-demand, scheduled, and forecast reports individually in Report Inbox, or 
simultaneously in the Inbox Manager application.
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Scheduled Reports sets up timetables for generating Agent, Queue, Employee, Team, Extension, Trunk, 
4Sight, and DNIS reports.

When you click Reporting=>Scheduled Reports Figure 1-15 appears. This is where you create and manage 
schedules.
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The following exercises will familiarize you with Scheduled Reports. Using a Queue Group Abandon 
Spectrum by Queue Report you will

      •    Create a report schedule.
      •    Associate a report to the schedule.
      •    Review report details.
      •    View the report grid and chart in Excel.
      •    Generate a scheduled report immediately.
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If you intend to e-mail the report to one or more recipients you must add the recipients to a mailing list and 
associate the recipients to a group.

To set up groups for e-mailing reports:
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To create a schedule for producing reports:
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A screen for selecting schedule parameters appears.

Under Reports Time Span, if you select Year to Date, the report output includes all days from 1 January to 
the present date. You can optionally select the From Given Start Date to Current Date option and produce 
reports for your fiscal year.

If you select printing and mailing options, the Report Distributor prints and e-mails all of the reports 
included in the schedule (on the date the system runs the reports).
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A screen for selecting report categories appears.
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You can associate one or more reports to a single schedule.

To associate a report to the current schedule:
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A screen for selecting queue and queue group report options appears.
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NOTE: You can generate multiple queue group reports simultaneously by selecting more than one queue 
group in the Queue Group list and clicking Submit. This function applies to all report types.
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A screen confirming the reports were added to the schedule appears. You can click Add Report (to add an 
additional report to the active schedule) Manage Schedule (to review schedule status details) or Scheduled 
Report Menu (to create a new schedule).

Consider the schedule parameters you have defined. At the specified time, Report Scheduler will generate 
reports associated with your schedule. It will place them in your inbox, print them in hard copy, and e-mail 
them to the group you selected.
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To view schedule details for the reports associated with the active schedule:







�

����4
��������%���� ��

Figure 1-16 appears.

��������	�
����������������

A screen that provides schedule details for the reports associated with the active schedule appears.
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The Report Type field lists the report name and the Device field lists the ID of the device on which you are 
reporting.
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NOTE: 6110 CCM permissions are based on database teams and groups. If you have the SX-2000, you can 
use the Quick Configuration tool to create associations. In programming the YourSite Database, you must 
create agent IDs and associate the agents to employees and to agent groups. You must associate the agent 
groups to the queues for which they answer calls. You must associate the employees to employee groups 
and the queues to queue groups. You must create these associations in the database in order to view real-
time data and report on these devices. If you are reporting on extensions, trunks, DNIS numbers, and 
account codes, you must add these devices to the YourSite Database and associate the extensions to 
extension groups, trunks to trunk groups, and DNIS numbers to DNIS groups.

To view the report grid and chart:
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When you click View, the client-side Report Writer (Web page) retrieves the data files from the 6110 CCM 
Enterprise Server and re-creates the data set on your computer. It starts Excel and displays the Queue Group 
Abandon Spectrum by Queue Report spreadsheet and graph. If you click View to open a second report, 
Report Writer displays it in the same Excel session.
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In scheduled Reports, typically you create a schedule, associate reports to it, and specify the date and time 
you would like the reports to be run. On the Scheduled Reports main screen, under Execute Schedule Now, 
you can select a schedule and generate the reports associated with the schedule immediately.

To generate scheduled reports immediately:
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A screen displaying details for the schedule appears.
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Scheduled reports generates the reports associated with the schedule and files them to your personal report 
inbox immediately.
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Effective call center management involves having the right resources in place at the right times to handle an 
accurately forecasted workload at the desired level of service. Finding the right balance between resources 
and traffic volumes is critical. 4Sight accurately predicts your resource requirements.

Conducting a forecast involves accurately estimating the three components of call load: talk time, wrap up 
time, and call volume. 4Sight applies the Erlang C equation to the estimated call load and average talk time 
and predicts the agent requirement for your service level percentage and service level time targets.

When you click Reporting=>4Sight Figure 1-17 appears.
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The following exercises will familiarize you with 4Sight. You will learn how to

      •    Generate a run-on-demand forecast report.
      •    Review report details.
      •    View the forecast report grid and charts in Excel.
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If you intend to e-mail the report(s) (associated with your schedule) to one or more recipients you must add 
the recipients to a mailing list and associate the recipients to a group.

To set up groups for e-mailing reports:
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To run the report:
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The Select Report Options screen appears. The Report type list specifies the type of forecast report you 
produce: 4Sight Forecast (queue) or 4Sight Group Forecast (queue group). 
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The Start date and End date specify the date range for the historical data you use in the forecast.
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The Report Confirmation screen appears.
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The Report Inbox application displays all run-on-demand, scheduled, and forecast reports generated under 
your user name.
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After you run a forecast, you can perform “what-if” scenarios on the resultant data by changing the value of 
parameters displayed in the Excel spreadsheet and clicking 6110 CCM=>Recalculate to recalculate the 
results.
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4Sight uses default service level percentage (80%), service level time (20 sec), and wrap up time (15 sec) 
values in calculating the agents required. You can change the values for the calls offered, average talk time, 
wrap up time, and service level percentage and time and recalculate the number of agents required.

For example, you can reduce the average talk time and recalculate the agents required and the calls handled 
across 15-minute time intervals for the shift.
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If you have the add-on Mitel Networks 6120 CCS (Contact Center Scheduling) scheduling application, you 
can export data from the 4Sight-Excel spreadsheet to 6120 CCS and schedule agents.
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Read the following questions and select one answer.
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The YourSite Database consists of Configuration and Security components. You add elements and groups 
to YourSite in Configuration and program and enforce device level security in Security.
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The following exercises will familiarize you with YourSite. Using agents, agent groups, queues, and queue 
groups you will

      •    Add elements.
      •    Add database groups.
      •    Add elements to database groups.
      •    Security

�������������
When you click YourSite=>Configuration Figure 1-18 appears.

��������	�2��8���������������������� ����������

The Configuration module is comprised of the following tabs: Employee, Employee Group, Agent, Agent 
Group, Team, Queue, Queue Group, Extension, Extension Group, Trunk, Trunk Group, Account Code, 
Automatic Number Identification (ANI), Dialed Number Identification Service (DNIS), DNIS Group, and 
Make Busy Reason Codes. Each of these tabs contains one or more grids with records. A record is a set of 
entries for a particular element.
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In an ACD call center using 6110 CCM there are two main databases: the telephone system database and 
the prairieFyre YourSite Database. In the Configuration module, you program YourSite to mirror the 
trunks, lines, routing and timing options, and agent positions in use on the telephone system.
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Before you program devices and device groups in the YourSite Database you must consider your needs.

(��������
      •    Will you report on all devices and device groups, or only on agents, agent groups, queues, and queue 

groups?

(������ �
      •    SuperAdvisor and AgentAdvisor display statistics on agents, agent groups, queues, queue groups, 

employees, and employee groups. You must configure these devices in the YourSite Database and 
associate them to groups in order to view data on them in real time.

4����������
      •    Agents log on to the chat module using employee IDs: you must configure them in the database.

NOTE: 6110 CCM permissions are based on database teams and groups. If you have the SX-2000, you can 
use the Quick Configuration tool to create associations. If you have the SX-200 or SX-200 with real-time, 
then you must configure 6110 CCM in the traditional manner. In programming the YourSite Database, you 
must create agent IDs and associate the agents to employees and to agent groups. You must associate the 
agent groups to the queues for which they answer calls. You must associate the employees to employee 
groups and the queues to queue groups. You must create these associations in the database in order to view 
real-time data and report on these devices. If you are reporting on extensions, trunks, and employees, you 
must add these devices to the YourSite Database and associate the extensions to extension groups, trunks to 
trunk groups, and DNIS numbers to DNIS groups.

&���.
���!���������
/���
There are now two ways to configure Mitel Networks 6110 CCM: the quick configuration tool or the 
traditional configuration. The quick configuration tool works only for the SX-2000. 

+���,�������������������
The quick configuration tool works only for the SX-2000. 

prairieFyre created the Quick Configuration Tool to help our customers configure Mitel Networks 6110 
CCM quickly and efficiently. 

First, you must convert the Mitel Assignment forms to .txt files. The Agent Group Assignment Form and 
the Path Assignment Form are found on the PBX. Then you configure Agents, Agent Groups, and/or 
Queues with the Quick Configuration Tool.
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On the PBX, you now send all valid Agent Group Assignments and Path Assignment to the file. Save the 
text file and proceed to Configuring Agents, Agent Groups, and/or Queues. 
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A legend appears that indicates if the data has been successfully added, if it already exists, or if it was not 
selected.
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If you have the SX-200 with real-time or the SX-200, you must configure the database the traditional way.

���������� ��������8�������
You can add elements, such as agents, extensions, trunks, and account codes to YourSite.

To add elements to yourSite:
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On the Employee tab, you must enter an employee ID for each call center agent and associate the employee 
ID to the agent ID. The agent ID and employee ID for an agent can be identical, or different. The choice is 
yours. It is important you do not assign the same employee ID to two agents; agents must have unique 
employee IDs.

After you add the data, you can double-click grid headers and sort the data by ascending or descending 
order.

To add agents to YourSite:
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To add queues to YourSite:
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The Queue tab displays agent groups that belong to the queue selected in the Queue list. You define queue 
dialable numbers, reporting numbers, names, service level time, short abandon time, and short talk time 
values for queues by right-clicking the grid and clicking Add. You can optionally add a series of queues to 
YourSite by clicking the Quick Setup button. After you add the data, you can double-click grid headers and 
sort the data by ascending or descending order.

+�����9���������:��� )��
Users often get confused when programming queue numbers. prairieFyre refers to the telephone system 
path reporting number as the queue number. When you program the telephone system with a path number 
such as six, you enter this number in YourSite as queue number P006 (for the SX-2000) or P0006 (for the 
SX-200 and the SX-200 with Real Time). Queue numbers are four digits in length: P001 (for the SX-2000), 
or five or six digits in length: P0001 or P00001 (for the SX-200 and the SX-200 with Real Time).



++



��
���
 ���
5�������
For the SX-2000, the database expands any dialable number that is less than three digits. For example, if 
you enter a queue number comprised of fewer than three numeric characters, such as P1, YourSite adds two 
zeros preceding the 1, as does your telephone system. If you enter a queue number of P30, the database 
expands the number to P030. For the SX-200 and SX-200 with Real Time, the database expands any 
dialable number that is less than four digits. For example, if you enter a queue number of P30, the database 
expands the number to P0030.

NOTE: For the SX-200 and the SX-200 with Real Time, the dialable number and queue reporting number 
you define (in YourSite) for a particular queue must be identical. If you use 5300 as the dialable number for 
the primary customer service queue, you must use P5300 for the corresponding queue reporting number.

�����)��
The Dialable field specifies the number the caller dials to reach a device.

�������)����� 0� �
The Short Abandon Time field specifies the minimum time a caller must wait before abandoning a call in 
order for the system to collect statistics on the call (for the queue).

Callers abandon after they reach a trunk (before they reach the ACD queue) or while they are in queue 
waiting for an available agent (either before or after the short abandon time you specify). The telephone 
system collects statistics on both types of abandons. You assign short abandon time values to ACD queues 
in YourSite to exclude call statistics on callers who abandon shortly after reaching an ACD queue from 
queue calculations.

������0��, 0� �
The Short Talk Time field specifies the minimum time an agent must talk to a caller in order for the system 
to collect statistics on the call (for the queue).

���&���
The Service field specifies the service level time for the queue.

The service level identifies the average length of time a caller who has obtained a trunk waits for an 
available agent. You use it in calculating the agent requirement. The service level = (calls answered + calls 
abandoned in Y seconds) ÷ (calls answered + calls abandoned after the short abandon time). It excludes 
statistics for calls abandoned quickly, without discounting abandoned calls entirely.

The service level is comprised of the service level percent and service level time. The service level time is 
the threshold time used in calculating the service level percent, such as 90 percent of calls answered in 20 
seconds. The service level percent and service level time parameters comprise your service objective.
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NOTE: If you attempt to add a group to YourSite that is already in the database the system notifies you that 
the group is already present. When you add a series of groups to YourSite, such as Extension Groups 1 to 5, 
if the system detects you have already added Extension Group 3, then it will not add Extension Group 3 or 
any subsequent extensions in the series (that is, Extension Group 4 or 5) to the database.

To add employee groups to YourSite:







�

����4
���
.�$ 
(���)�
�$
��"�

The Employee Group tab displays members who belong to the employee group currently selected. You 
define employee group reporting numbers and names by right-clicking the grid and clicking Add.
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To add agent groups to YourSite:
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The Agent Group tab displays members who belong to the agent group currently selected. You define agent 
group reporting numbers and names by right-clicking the grid and clicking Add.
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To add queue groups to YourSite:
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The Queue Group tab displays members who belong to the queue group currently selected. You define 
queue group reporting numbers and names by right-clicking the grid and clicking Add.
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To add an agent to an agent group defined in YourSite:
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At its most basic, security can be programed to either grant total access to the Website, or to totally restrict 
access. 
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Figure 1-19 appears.
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Figure 1-20 appears. The users and their associated security roles are listed here.
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Figure 1-21 appears. 
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If you create new Security Roles, they will be listed here. 
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You must create a User List, a Report List, and/or a Device List before you create an Advanced Security 
Role. With these lists, you can fine-tune a Security Role. The User List restricts access to employees Chat. 
The Report List restricts access to report types. The Device List restricts access to historical reporting, real-
time, and 6115 CCM statistics.
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You create a User List to restrict access to Chat.
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The Security List Administration window appears.
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The Report List Administration - User List, Figure 1-22 appears.
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You create a Report List to restrict specific report types on specific users. For example, you might want 
manager to view only Employee Reports (specific report type) on the employees they manage only 
(specific devices). By creating a Report List, you can restrict access to that specific report type only.
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The Security List Administration window appears.
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The Report List Administration - Add Report List window, Figure 1-23 appears.
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There is now a only Employee Reports Report List. See the Security List Administration window, 
Figure 1-24.
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You create a Device List to restrict access to statistics on specific users. For example, you might want a 
manager to view only Employee Reports (specific report type) on the employees he manages only (specific 
devices). By creating a Device List, you can restrict access to those specific employees only.

A Device is real-time or 6116 CCM statistics from which you can create a historical report or view real-
time or 6115 CCM statistics: Agents, Agent Groups, Queues, Queue Groups, Extensions, Extension 
Groups, Trunks, Trunk Groups, Employees, Employee Groups, Teams, and DNIS. 
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The Security List Administration window appears.
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You can click on the Device Group Type to view the members. This is for reference only. 
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Figure 1-25 appears.
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There are two categories of Security Role: Basic and Advanced. You can create a Basic Security Role to 
restrict user access to specific applications, or you can create an Advanced Security Role to restrict user 
access to customized lists: Device Lists, Report Lists, and/or User Lists.

NOTE: For you to assign security roles, your account must be associated to a security role that does not 
restrict you from administering security.   
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When you first access the Mitel Networks 6100 CCM Web site, users by default have total access to the 
Web site. If you want some users to have access to the Web site, but do not want them to have access to 
everything (for example, you do not want them to administer security) then you must create a Security Role 
with that characteristic. 
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Figure 1-26 appears.
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The name of the security role you just created appears under Name.

There are now two security roles: the original security roles (Not Restricted) and the security role you just 
created. You can assign the new security role to new users, or you can edit the current users’ existing 
security roles to that of the new security role.

Users who are currently logged on will not be affected by changes made to their associated role until the 
next time they log on. If you want the security role changes to take effect immediately, start and stop the 
6110 CCM Web site from the Internet Server Manager. All clients will be disconnected and forced to re-log 
on. 
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You must create a User List, a Report List, and/or a Device List before you create an Advanced Security 
Role. With these lists, you can fine-tune a Security Role. The User List restricts access to employees Chat. 
The Report List restricts access to report types. The Device List restricts access to real-time and 6115 CCM 
statistics.
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Once you create a Device List you can create an Advanced Security Role that restricts access to reports, 
based on the Report List. See Figure 1-27.
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Once you create a Device List you can create an Advanced Security Role that restricts access to real-time 
and 6115 statistics, based on the Device List. 
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Once you create a User List you can create an Advanced Security Role that restricts access to Chat, based 
on the User List. 
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Read the following questions and select one answer.
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Inspector finds specific call center events, such as the exact time an agent logs off at lunch, and the duration 
of time agents spend in Do Not Disturb (DND) from 1:00 P.M. to 2:00 P.M. on Monday. In a single session, 
you can search through the data from multiple days to find a specific event. The results are placed in an 
easy-to-interpret grid that you can print or save to file. You can verify your reports are valid by conducting 
searches against raw telephone system data. Inspector consists of ACD and SMDR search tools.
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The following exercises will familiarize you with Inspector. You will learn how to

      •    Run searches in ACD Inspector and interpret the search results.
      •    Run searches in SMDR Inspector and interpret the search results.
      •    Run searches in Advanced Inspector and interpret the search results.

When you click Tools=>ACD Inspector Figure 1-20 appears.
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In ACD Inspector you can run a search on agent event, queue event, time range, and advanced criteria.



�/
+������
��������
��
��%
6��������
The following two examples demonstrate how to run searches in ACD Inspector.
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Suppose you want to view the longest waiting records for Queue P001 on March 15, 2000.

To examine the longest waiting records for queue P001:
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The ACD Search Criteria screen appears.
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The ACD Inspector Results - Agent Events screen appears.
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Figure 1-21 appears.
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The first record in the search output shows that at 08:59:31 hours 4 calls waited in queue and the longest 
waiting caller waited eight minutes and fourteen seconds. There were 6 agents logged in (and busy).
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Suppose you want to confirm the time Agent 1281 first logged in for the day.

To examine log on and log off records for Agent 1281:
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Figure 1-22 appears.
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The search output shows that Agent 1281 logged in to Extension 6976 at 07:14:31 hours on March 15, 
2000.
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When you click Tools=>SMDR Inspector Figure 1-23 appears.
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In SMDR Inspector you can run a search on the digits dialed, the time range, call types, and advanced 
criteria.
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The following three examples demonstrate how to run searches in SMDR Inspector.

�$� �����
Suppose your company policy permits agents to make outbound calls as long as the duration is kept to a 
minimum. Your reports show that Agent 6133 made outbound calls on March 15, 2000 and you want to 
confirm if any of these calls were longer than six minutes.
To examine the outgoing calls made by the agent:
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The SMDR Inspector Criteria screen appears.
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Figure 1-23 appears.
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The first record in the search output shows that on March 15, Agent 6133 made an outgoing call at 8:11 
A.M. that lasted thirty minutes and thirty-five seconds.

�$� �����
Suppose your reports show that eleven calls were abandoned on Queue P121 on July 27, 2000 and you 
wanted to confirm this information.

To examine all of the abandoned calls that were offered to Queue P121:
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The Call Types screen appears.
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Figure 1-24 appears.
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The first record in the search output shows that at 11:02 A.M. there was a call to P121 that abandoned after 
seven seconds. The search output confirms that a total of eleven calls were abandoned on Queue P121 on 
July 27.
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Example 3 demonstrates how to run an advanced search in SMDR Inspector. The Advanced search verifies 
the agents, agent groups, and queues not programmed in the Yoursite Database.

Suppose your Agent Group and Queue Reports do not line up: your Agent Group Report shows less calls 
answered than your Queue Report. You know that only one Agent Group is scheduled to answer calls for 
the queue. You need to find out which other agents were answering calls for the queue.

To determine which other agents answered calls for the queue:
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You enter information in the Queue box or the Agent box when you perform a search.

When you type a queue number in the Queue box, the search output displays

•    The agents that answered calls for the queue that are programmed in the Yoursite Database
•    The agents that answered calls for the queue that are not programmed in the Yoursite Database
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When you type an agent or queue number in the Agent box, the search output displays

•    The queues or agent groups for which the agent answered calls that are programmed in the Yoursite 
Database for the agent

•    The queues or agent groups for which the agent answered calls that are not programmed in the    
Yoursite Database for the agent
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Figure 1-25 appears.
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The search output shows

•    The agents that answered calls for P121 that are programmed in the YourSite Database
•    The devices (extensions and agents) that answered calls for P121 that are not programmed in the 

YourSite Database.

You can print the search results and compare them to the YourSite database programming.

NOTE:  When you perform an advanced search, SMDR Inspector ignores all other search criteria.
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When you click Tools=>Advanced Inspector Figure 1-26 appears.
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Using Advanced Inspector, you can determine why there are discrepancies between reports, verify the 
programming of the telephone system and the YourSite Database, and compare the data output by the ACD 
and SMDR data streams. The results are displayed in a table. The search output also provides a written 
explanation for the results.
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The following three examples demonstrate how to run searches in Advanced Inspector.

�$� �����=�>�����������������1����� �����)��1������(�����������������
�&����)��1������(����������������?
This search compares the SMDR and ACD data streams for agent events by time. You can search on ACD 
answered calls, personal answered calls, and/or outgoing calls.

Suppose you compare the Agent Performance by Period and Agent Event by Period Reports for a particular 
agent, and notice a discrepancy in the number of calls answered by the agent.
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To examine the SMDR and ACD data streams for ACD answered and personal answered calls:
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Figure 1-27 appears.
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The search output for ACD answered and personal answered calls shows a discrepancy between the records 
produced by the ACD stream and those produced by the SMDR stream. The ACD stream produced a 
record for a personal call made at 12:21:22 and the SMDR stream did not.

The search output provides numerous possible explanations. The call center has an SX-200. The SX-200 
does not support internal SMDR records, which is why the call was not reported by the SMDR stream.

�$� �����=����*���&����(���������������������������?
If you have an SX-2000 and the Internal Calls option is enabled on the telephone system, the output from 
this search provides all of the SMDR call records that pertain to internal calls, for one or more CEN nodes.

Suppose you think your agents are answering more calls than your agent reports suggest. This may be 
because Internal SMDR is not enabled on your telephone system and 6110 CCM is not reporting on internal 
calls.
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To determine if you have internal SMDR enabled on the telephone system:
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Figure 1-28 appears.
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The message in Figure 1-28 pertains to the SX-200. The SX-200 does not produce SMDR records for 
internal calls. If you have an SX-2000 and have not purchased the Internal SMDR option and enabled it on 
the telephone system, or no data was generated for internal calls, the search will not report any SMDR 
records for internal calls.

�$� ����"=����*���&���$����������������� �������)�������������� ����������
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This search compares the YourSite Database programming and the SMDR and ACD data streams to 
determine if the record format for a particular node has extended agent or extension IDs.

Call centers with extended agent or extension IDs (IDs greater than four digits) must have the Extended 
SMDR option enabled on the telephone system (SMDR Options/COS Assignment form) to prevent the 
telephone system from truncating the call record data.

Suppose your extension reports do not show any data. This can occur when the extension numbers in the 
YourSite Database are not associated to extension groups, or differ from those programmed in the 
telephone system. This can also occur when the extension numbers in the telephone system are greater 
than four digits and Internal SMDR is not enabled in the telephone system.
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To examine the YourSite Database and SMDR and ACD data streams for extended record formats:
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Figure 1-29 appears.
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The ACD and SMDR data streams are generating extended agent or extension ID records. This 
means the telephone system is programmed with extended IDs and the Extended SMDR option is 
enabled. The agent and/or extension numbers in the YourSite Database are not extended. You must 
configure the agent and extension IDs in the YourSite Database to mirror those of the telephone system.
Table 10-2 describes the possible search output scenarios and what they mean in terms of the programming 
of the telephone system and the YourSite Database.
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n n n The telephone system and the YourSite Database have 
agent or extension IDs with four digits.

e e e The telephone system and the YourSite Database have 
agent or extension IDs greater than four digits.

e n n The telephone system has agent or extension IDs greater 
than four digits. The ACD and SMDR data streams are not 
generating extended ID records, possibly because 
Extended SMDR is not enabled. The YourSite Database 
has agent or extension IDs greater than four digits. Enable 
Extended SMDR on the telephone system.

n e e The ACD and SMDR data streams are generating 
extended agent or extension ID records. This means the 
telephone system is programmed with extended IDs and 
the Extended SMDR option is enabled. The agent and/or 
extension numbers in the YourSite Database are not extended. 
You must configure the agent and extension IDs in the YourSite 
Database to mirror those of the telephone system.

n e n The ACD data stream is generating extended agent or 
extension ID records, which means the telephone is 
programmed with extended IDs. The SMDR data stream is 
generating records with four digits: the SMDR records 
could be truncated. Ensure the Extended SMDR option is 
enabled. You must configure the agent and extension IDs in the 
YourSite Database to mirror those of the telephone system.
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Read the following questions and select one answer.

�
'����
�����#���
��
���
����H






��

7�
�
������
�������(
	��
���
������
�������
���
!���
���#
#�������
!�	��





"�

6���
������
��������������
!�
���
����
��
"�
�2����





��

���0
7��������
��������
��
����
�������





!�

���
7��������
��������
��
�����
��!
8����
�������





��

7��������
��������
��
!���
���#
���
�������
	���
���	�

,�
'���
������#���
��
�!�����!
������
��
���0
7��������
	��






��

�����
�����#�����
��
���
3����
��
������
>�
"�2
� �
���
�����
��
������
>�
"�2





"�

���
!����#���
���
8�����
��
�����
������
���
�����
���
�����
�������!
�����
����




���
���
������##�!
��
���
6�������
����"���
���
���
�����





��

���
������
��
!����
��!
��#�
������





!�

���
!����#���
���
������
����
�������!
�����
���
���
8����
����
���
���
������##�!


��
���
6�������
����"���





��

�����#����
�(
"(
��!
!
���
�����





��

�����#����
"(
��!
!
���
�����





��

���
��
���
�"���
�����#����
���
�����



$
�	

 �	����
The WallBoarder application displays text messages and call center statistics on one or more Spectrum 
Light Emitting Diode (LED) reader boards (wall signs). Wall signs provide real-time statistics to agents and 
supervisors, such as the number of calls in queue, the wait time of the longest waiting caller, and the 
number of available agents. You can define display characteristics and alarm thresholds for ACD variables.

When a call center has more than one wall sign they are networked together. The first wall sign connected 
to the 6110 CCM Enterprise Server is the master sign. All other wall signs are slave signs. The prairieFyre 
Service updates WallBoarder with telephone system statistics every second.

When you click RealTime=>WallBoarder Figure 1-30 appears.

��������	"���>���-������� ����������

WallBoarder provides the following functions:

      •    The Maintenance screen resets the wall sign.
      •    The Variables screen defines the appearance of displayed performance variables.
      •    The Messages screen programs wall sign messages.
      •    The Groups screen assigns wall sign messages to sign plans.
      •    The Priority Messages screen programs priority messages.

�����
������ ��
The following exercises will familiarize you with WallBoarder. You will learn how to

      •    Reset and synchronize your wall signs.
      •    Define threshold characteristics for wall sign variables across ACD queue groups.
      •    Construct message strings of user-defined text, sign variables, display features, and graphics.
      •    Define sign groups which specify the conditions in which real-time information is displayed on one 

or more wall signs.
      •    Schedule priority messages to provide timely information to agents.
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To reset and synchronize the wall signs:
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The Variables screen illustrated in Figure 1-31 provides the pool of ACD performance variables 
WallBoarder uses to configure wall sign messages. You define and save display characteristics for sign 
variables (ACD variables associated with a particular ACD queue) on the Variables screen.

Consider the programming for Sign Variable #1 (Calls Wtg - P002) in Figure 1-31. The value for the Calls 
Waiting in Queue statistic will be displayed in amber when less than 10 callers are waiting in P002, in green 
when 10 to 15 callers are waiting in P002, and in red at other times (when 16 or more callers are waiting in 
P002).

��������	"���@����)����������

����������������@����)��
The Editing Current Variable group displays the current (active) sign variable. You select the Enabled 
check box to define alarm characteristics for the active variable and make it available for WallBoarder to 
incorporate in message strings.
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The Variable Type list associates an ACD variable to the active sign variable.

@����)���*��3��,���0�
The Variable Is Linked To group associates a queue or queue group to the active sign variable.

5��������/�������%
The Variable Displayed group specifies the number of characters reserved for an ACD variable in the 
message string. It centers, left-justifies, or right-justifies the ACD variable within the variable string 
position. prairieFyre recommends you use a variable spacing of one to three character widths. The 
following example shows a width of three characters for the Calls Waiting in Queue ACD variable. The 
real-time value is right-justified in the variable string position.

CALLS WAITING =   1 0

@����)���������0������������@����)���@����
The Variable Color Triggers to Variable Value list defines color-coded alarms for ACD variable 
performance thresholds.

To define sign variables and associated display characteristics:
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You have defined sign variables. The next step in configuring wall sign messages is to construct a global 
pool of sign messages.
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You compose, test, and save message strings displayed on wall signs on the Messages screen illustrated in 
Figure 1-32. Message strings indicate to the wall sign how messages are displayed. They are constructed of 
ACD variables, text, display features, and optionally graphics.
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Consider the message string defined in the preceding figure. WallBoarder displays the message string on 
the top line [PS02-Top Line] of the wall sign. It displays the Calls Wtg = component of the message string 
in rainbow colors [C005-Rainbow]. The message string flashes [MO03-Flash] across the sign and twinkles 
[SP01 - Twinkle]. It is comprised of text you type (Calls Wtg =) and Sign Variable #1 [VA01-Calls Wtg - 
All Paths], which displays the real-time value for the Calls Waiting in Queue ACD variable. The color of 
the sign variable statistic changes with the number of callers waiting in queue, as per the threshold settings 
defined on the Variables tab.

����������������������
The Editing Current Message group displays the current (active) sign message. You select the Enabled 
check box to define display characteristics for the active sign message and make the message available to 
WallBoarder to incorporate in sign groups.

1�������
The Position tab specifies the vertical position of the message string on the wall sign. If you do not specify 
the text position, the wall sign defaults to the fill mode: the message enters the wall sign from the upper left 
corner and scrolls to fill up to three rows of text. If you specify the text position, do so before setting other 
display features.

������
The Colors tab specifies the color of text you type in the message string, and the color of any pre-defined 
text and graphics you select on the Special tab. You can specify different colors for each word in the text 
string. If you specify text coloring, do so after specifying text positioning, but prior to specifying other 
display features. Some Spectrum signs offer more color choices than other Spectrum signs. Please refer to 
the Spectrum product brochure for more information.
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The Effects tab specifies how messages move across wall signs. If you do not specify effects, the wall sign 
defaults to the Automode option. Automode produces random message display formats, such as message 
strings that flash or roll to the left.

�������
The Special tab provides display features and illustrations you can add to message strings.

������������
The Miscellaneous tab specifies the speed at which WallBoarder displays message strings, the size of 
message string text, the display time and date, and other features.

@����)���
The Variables tab associates ACD variables and ACD queues to sign variables, and specifies display 
characteristics and color-coded alarm thresholds.

When you incorporate a sign variable, such as Sign Variable #6, in a message string, the real-time value of 
the associated ACD variable is displayed.

To define sign messages:
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You have defined a global pool of sign messages. The next step in configuring wall sign messages is to 
define sign groups and specify the conditions in which sign messages are displayed on one or more wall 
signs.
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You define sign groups on the Groups screen illustrated in Figure 1-33. Each wall sign has a unique 
address. Only sign messages addressed to a particular wall sign will reach the wall sign.
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Each sign group has a range of sign addresses. For example, you can specify that Sign Group #1 provides 
real-time displays for wall signs one through five, Sign Group #2 provides real-time displays for wall signs 
six to 10, and so on.

You can specify up to four statements (conditions) using sign groups. Conditions dictate which message 
strings WallBoarder displays, and the priority in which WallBoarder displays them.

Consider the sign group programming defined in the preceding figure. The first condition specifies “If Sign 
Variable #1 (the Calls Waiting in D1000) exceeds 10 play Sign Message #01.” The second condition 
specifies “If Sign Variable #2 (the Longest Waiting Caller in D1000) exceeds 45 seconds play Sign 
Message #03. “The third condition specifies “If Sign Variable #3 (the ACD Agents Logged On to D1000) 
drops below 6 play Sign Message #02.”

���������������������A����
The Editing Current Sign group displays the current (active) sign group. You select the Enabled check box 
to define the conditions in which message strings are displayed, and the priority in which they are displayed 
for the active sign group.

����������B3��������
The First Sign and Last Sign boxes associate the active sign group to a range of wall sign addresses. Each 
sign group specifies the real-time display characteristics for a unique range of wall signs. For example, if 
you associate Sign Group 1 to wall signs one through eight, these wall signs display the same set of sign 
variables and message strings.

*�
The If check box provides access to conditional messages. You can specify up to five statements 
(conditions). Conditions dictate which message strings WallBoarder displays, and the priority in which 
WallBoarder displays them.
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The Sign Variable list specifies the sign variable to display for the current (active) condition.

�&��������0�
The Evaluates To group specifies the value, above or below which, WallBoarder displays the message 
string associated with the sign variable for the current condition.

1����������
The Play Message list specifies the sign message to display for the current (active) condition.

-���
The Beep check box programs the wall sign to produce an audible beep prior to displaying a message for a 
satisfied condition.

������������������1����*��6��@����)����C�&��0���������������������1���
The Default Message to Play If No Variables Have Triggered a Message to Play list specifies a default 
message to display on the wall sign. WallBoarder displays the message during periods when the defined 
conditions (“If” statements) are not satisfied for the sign group.

To define sign groups:
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This completes the programing of wall sign messaging for your call center. You can optionally define 
priority messages that WallBoarder displays at particular time intervals over the day.
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You can schedule priority messages, such as a message each day from 5:00 P.M. to 5:15 P.M. reminding 
agents to log off at the end of their shift.

The Priority Messages screen resembles the Messages screen. When you select the Enabled check box, 
WallBoarder displays the current (active) priority message on all wall signs until you manually clear the 
check box; priority messages override all other sign messages.
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You can define up to five priority messages. WallBoarder lists the messages in the Editing Current Priority 
Message list. Typically, you define a unique display schedule for each message, such as Priority Message 
#1 runs from 5:00 P.M. to 5:30 P.M. and Priority Message #2 runs from 5:30 P.M. to 6:00 P.M. In the event 
that two or more schedules overlap, the order in which you list the messages dictates the priority in which 
WallBoarder displays them.

To define priority messages:
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Read the following questions and select one answer.
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The telephone system generates an enormous amount of real-time and historical data used to manage your 
call center. You use real-time data to monitor the current call load and agent availability and make minute-
to-minute adjustments. You use historical information for forecasting, staffing, and scheduling.

When you right-click the 6110 CCM Network Monitor icon (the black figure on the system tray), click 
Node Information, and expand all of the nodes on the 6110 CCM Enterprise Node tree, Figure 1-34 
appears.
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The CEN node tree lists all of the local and remote nodes in the enterprise, as defined in the Management 
Console application. A node is a data collection point for a single SX-2000 or SX-200 telephone system.

Figure 1-34 displays two local nodes. Note that the local nodes share the same IP address as the 6110 CCM 
Enterprise Server, but have unique IP port numbers. Remote nodes (nodes that reside in call centers within 
your enterprise that do not have 6110 CCM Enterprise Server software installed) have a different IP address 
and IP port number than the 6110 CCM Enterprise Server.

When you right-click the 6110 CCM Network Monitor icon a menu appears with the following options.

6����*���� �����
The Node Information command lists all of the local and remote nodes in the enterprise, as defined in the 
Management Console application.

���)���1���<�������
The Enable Pop Up Alert command enables a pop-up alert function that displays system and data alarm 
information.

���)��B����)������� �-���

A red line appears through the ACDLink icon to alert you to prairieFyre Service errors. The Enable Alarm 
command disables the audible alarm.

�����������������
The Client Statistics command displays statistical information on enterprise clients for the collector service. 
It provides a view into the collector service running on your local computer.
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The Connect To command connects and disconnects the ACDLink application from the prairieFyre 
Service. If you accidentally disconnect the ACDLink monitor from the prairieFyre Service, the 6110 CCM 
Network Monitor icon blinks.

�������B������
The English and French commands display the ACDLink UI in English or in French.

(�*�������!�����������
The ReInitialize Collector command reconnects the ACDLink application to the Collector Service. If you 
accidentally disconnect the ACDLink monitor from the Collector Service, or the system detects Collector 
Service errors, the 6110 CCM Network Monitor icon (the black figure on the system tray) turns red and 
blinks. The Summary of Alarm Status screen displays the errors.

�$��
The Exit command quits the ACDLink application.
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The following exercises will familiarize you with the 6110 CCM Network Monitor. You will learn how to
•    Start ACDLink and view real-time data collection for all nodes (collection points).
•    View data and system alarms.
•    Enable an alarm beep that notifies you of any data and system alarms.
•    Re-initialize the Collector.
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The ACDLink application displays real-time, telephone system data. You use ACDLink to monitor the 
6110 CCM Server, to verify the Collector Service is collecting real-time telephone system data, and to reset 
your SMDR and ACD data links.

The following information will equip you to maintain the 6110 CCM system and prevent data loss. 
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To start ACDLink on the 6110 CCM Enterprise Server:
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If the 6110 CCM Network Monitor is not active on the system tray, click Start=>Programs=>prairieFyre 
Software Inc.=>6110 CCM Network Monitor to start the monitor.

NOTE: By default, the 6110 CCM Network Monitor on the 6110 CCM Enterprise Server points to the 
default data collection point. The default data collection point is the 6110 CCM Enterprise Server Collector 
Service.

������������3��,��������������� �����
To start ACDLink on a client computer:
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Alternatively, you can click Tools=>ACDLink on the 6110 CCM UI to start the ACDLink application.

Figure 1-35 appears.
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ACDLink provides the following functions.

���&����������
The Server Started field displays the date and time you started the 6110 CCM Server.

���&��#����������0� �
The Server’s Current Time field displays the current date and time set on the 6110 CCM Server.
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The Alarm Status field displays system errors, such as SQL and comport errors. SQL errors occur when the 
connection to the SQL Server software is down. Comport errors occur when the data flow to the SMDR, 
ACD, and WallBoard comports is interrupted.

������������������� �
The Clear All Data Alarms button clears any current data alarms.

��(������6� �
The SMDR File Name field displays the name of the text file to which the Collector Service writes SMDR 
data. You can find the text file on the 6110 CCM Server in \\prairieFyre\6110 CCM\ACD Manager. The file 
naming convention is S (for SMDR) YYYY/MM/DD. The date in the text file name must match the date in 
the Server’s Current Time field.

��*
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The ACD File Name field displays the name of the text file to which the Collector Service writes ACD 
data. You can find the text file on the 6110 CCM Server in \\prairieFyre\6110 CCM\ACD Manager. The file 
naming convention is A (for ACD) YYYY/MM/DD. The date in the text file name must match the date in the 
Server’s Current Time field.

�����>�����������
The File Write Errors field displays a value for the number of times the Collector Service attempts to write 
to the 6110 CCM Server data drive (when the disk is full).

��%+
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The SMDR Data Stream field displays SMDR records as they arrive from the telephone system.

(�������0����
Under SMDR Data Stream, the Records Today field displays the total number of SMDR records received 
for the day.

(������������
Under SMDR Data Stream, the Record Errors field displays the number of records received by the 
Collector Service that were not valid SMDR records.

(������3����(����&��
Under SMDR Data Stream, the Record Last Received field displays the date and time the Collector Service 
received the SMDR record last sent.

(�������(�3��,
The Reset SMDR Link button resets the SMDR data link from the telephone system to the Collector 
Service when the SMDR Data Stream field shows no data is streaming. If you attempt to reset the link and 
data does not start streaming, check your cabling connections from the telephone system to the comports.

�������������� 
The ACD Data Stream field displays ACD records as they arrive from the telephone system.
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Under ACD Data Stream, the Records Today field displays the total number of ACD records received for 
the day.

(������������
Under ACD Data Stream, the Record Errors field displays the number of records received by the Collector 
Service that were not valid ACD records.

(������3����(����&��
Under ACD Data Stream, the Record Last Received field displays the date and time the Collector Service 
received the ACD record last sent.

(���������3��,
The Reset ACD Link button resets the ACD data link from the telephone system to the Collector Service 
when the ACD Data Stream field shows no data is streaming. If you attempt to reset the link and data does 
not start streaming, check your cabling connections from the telephone system to the comports.
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You can enable pop-up alerts that display system and data alarm information.
To enable pop-up alerts:
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If a system or data alarm occurs, the Figure 1-37 is displayed on top of all open applications.
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This message informs you that the Collector Service for the node has been disconnected from the telephone 
system.

You can disable the beep that accompanies an alarm by clicking the speaker button (displayed in the 
preceding figure). You can also prevent a message from re-appearing by selecting the Do not show alarm 
warning again check box.
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The ReInitialize Collector command reconnects the ACDLink application to the Collector Service. If you 
accidentally disconnect the ACDLink monitor from the Collector Service, or the system detects Collector 
Service errors, the 6110 CCM Network Monitor icon turns red and blinks. You can select the Summary of 
Alarm Status screen to see a summary of the errors.

NOTE: Only 6110 CCM users with “Manager” permissions can re-initialize the Collector Service.

To re-initialize the Collector Service:
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Read the following questions and select one answer.
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You use the Management Console application for troubleshooting problems, SQL database management, 
and SQL database object inspection. You can verify the existence of all critical 6110 CCM database 
objects, change your IP address and comport settings, and back up and restore the 6110 CCM database, or 
critical portions of the database.

You start the Management Console application on the 6110 CCM Enterprise Server. Before you start 
Management Console you must log on to the Windows NT Server with an account that has administrative 
privileges.

To start Management Console:
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Figure 1-38 appears.
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The main screen consists of System Settings, Database, and Enterprise tabs. You use the System Settings 
tab to change settings in the registry. You use the Database tab to view 6110 CCM database objects and 
perform diagnostics. All Database tab objects are read-only. The objects are comprised of tables, stored 
procedures, and database users. You use the Enterprise tab to verify telephone system settings and set ACD 
and SMDR comport settings for your site.

You logged on to the Windows NT Server to start Management Console. You do not need to log on a 
second time if you only want to change system settings, such as the wall sign comport value.
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You do not need to log on to the SQL Server to back up or restore the YourSite Database: SQL Server uses 
your current credentials.

You must log on to the SQL Server to gain access to all database menu options. To log on, you click 
Database=>Load SQL Databases. The first time you log on to the SQL Server, you use the following 
credentials:

Username: sa
Password:

prairieFyre recommends you change the sa password immediately after you first log on. To change it you 
click Database=>Change SQL System Administrator Password. Be sure to record the new password for 
your records. Do not disclose the password to anyone who does not absolutely require it.
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The following exercises will familiarize you with Management Console. You will learn how to

      •    Upload historical data from the telephone system.
      •    Edit registry settings.
      •    Set alarms for the prairieFyre Service.
      •    Back up and restore the YourSite Database.
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If you run a report and notice that data for a particular device is missing from the report output, you verify 
the device is programmed in the telephone system and in the YourSite Database. If you determine the 
device is missing from the YourSite Database, you add it to the database and use the Summarize Data 
command to update the prairieFyre Service and the SQL database with the complete telephone system data 
(that is stored on the local hard drive). You can then produce reports on the device.

To upload raw historical data from the local hard drive to the prairieFyre Service and SQL database:
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The Summarize Data screen appears.
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You can edit the following registry settings on the System Settings tab:

      •    Sign Comports
      •    HTTP Server IP Address used by the 6110 CCM Web application
      •    Data Alarms Schedule
      •    Data Alarm Time Out Minutes
      •    Auto Restart Data Ports
      •    Low Disk Space Threshold (MB)
      •    Time Maintenance Manager (Maintenance Service nightly routine) Runs
      •    Stop and Start SQL Server Once during Maintenance

You click File=>Reload System Settings to refresh the values displayed on the System Settings tab. You 
edit a registry setting by double-clicking it and entering one or more values.

You can edit registry settings on the Enterprise tab, such as the 6110 CCM Enterprise Server IP address and 
telephone system type. You can edit the SMDR and ACD comport settings, which instruct the prairieFyre 
Service on where to go to find data.
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You set alarms in Management Console so the system will notify you if the prairieFyre Service is not 
receiving data or the 6110 CCM Enterprise Server disk space is low.

To program the alarm schedule:
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The Data Alarms Schedule screen appears.
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The Data Alarm Time Out Minutes setting specifies how many minutes the system waits (when it detects 
the prairieFyre Service is not receiving data) before it raises an alarm.

�����������������(������������1������������
The Auto Restart Data Ports setting instructs the system to attempt to reopen the data ports when it detects 
the prairieFyre Service is not receiving data. Provided alarms are set, the system closes the comports for 30 
seconds and then attempts to reopen them.

������������3������,�������0����������������
The Low Disk Space Threshold setting instructs the system to monitor the disk space on the disk housing 
the text files and SQL database. If the disk space is less than the threshold specified, the system sets off an 
alarm in the SuperAdvisor application.
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This backup offers protection in case you program the database incorrectly, or a careless user reconfigures 
it. prairieFyre recommends you perform this backup weekly, in addition to regular database maintenance.
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This backs up the current programming in the YourSite Database to a file in your Temp directory. The 
naming syntax is MMDDYYYY.sql. If required, you can later recover the YourSite Database data 
exclusively, rather than restoring the entire SQL database.
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This restores the YourSite Database to the time of your last database backup.

NOTE: Restoring the YourSite Database deletes all current database table entries and replaces them with 
the entries defined at the time of your last database backup. Any changes made to the database in the 
interim are lost. Backing up the YourSite Database also deletes all report permissions defined for users in 
the Report Permissions component of YourSite.
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You use this backup for disaster recovery. prairieFyre recommends you perform this backup weekly, in 
addition to regular database maintenance.

You click Database=>Back Up 6110 CCM Database to back up the current 6110 CCM Database 
configuration to a file in your Temp directory. The naming syntax is PFDB_BackupMMDDYYYY.bak. If 
required, you can later recover the 6110 CCM Database information exclusively, rather than restoring the 
entire SQL database. Clicking Database=>Restore 6110 CCM Database restores the configuration database 
to the time of your last database backup.

NOTE: Call prairieFyre before you restore the 6110 CCM Database! Restoring the 6110 CCM Database 
deletes the entire 6110 CCM Database, which is the core of the 6110 CCM application. After you restore 
the database, you need to take further steps to re-enter the telephone system data in the database.
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Read the following questions and select one answer.
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